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PROTOCOL PRE-APPROVAL 

The Installation / Operational Qualification Protocol for the Veriteq vLog Software Version 4.4 has been 

reviewed and approved for execution by the following.  Signing this protocol indicates that the contents of 

this document have been reviewed, all test procedures are accurate and the acceptance criteria are 

applicable for the intended purpose of this study.  The following responsible functional areas have 

approved this Installation/ Operational protocol: 

 

Approved By:    ________________________________________   ______________  

Information Technology Date 

 _____________________________________________   ________________  

Operations Date 

 _____________________________________________   ________________  

Quality Assurance Date 
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Disclaimers: 

1. Prior to execution of this protocol, the following conditions must be met: 

a. Loggers have been attached to the system either directly via a cable connection or indirectly via a vNet 
or Digi PortServer device. 

b. All cables being used that require drivers have been properly installed on the vLog Server.   

c. All vNet and Digi PortServer devices being used have been setup with static IP addresses and correct 
network information, and have had their drivers installed on the vLog Server. 

d. All computers used in the vLog system must meet the minimum requirements as specified in the vLog 
documentation. 

e. The Veriteq vLog software has been installed on a computer used in this validation. 

2. The logger data cable must not become disconnected during transmission unless specified in the procedure and 
the logger in test must contain an adequate amount of data. 

3. The procedures in this protocol may not leave the system in an ideal configuration for your particular application, 
especially in the case of an upgrade from a previous version.  Review and modification of the system 
configuration is highly recommended following validation. 

 

 

 

 

 

 

Veriteq, a Vaisala company 

Unit 100 – 13775 Commerce Parkway 

Richmond, BC Canada V6V 2V4 

Tel: (604) 273-6850 

Fax: (604) 273-2874 

Toll Free: 1-800-683-8374 

Email: customersupport@veriteq.com 

Web Site: http://www.veriteq.com 

 

© Copyright 2010 Veriteq Instruments, Inc.  All rights reserved. Product and company names 

listed in this document are trademarks or trade names of their respective companies. 
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1 Purpose 

The purpose of this IQ/OQ protocol is to provide assurance that the Veriteq vLog Data Logging and 
Reporting System has been set up properly, is functional, and operates with a high degree of integrity, 
security and reliability. 

The Installation Qualification (IQ) protocol template has been designed to ensure that the system, composed 
of both the hardware and the software, has been installed correctly at the point of use. The Operation 
Qualification (OQ) protocol template has been designed to ensure that each component of the system 
performs as intended. 

Veriteq loggers use Coordinated Universal Time (UTC) to create a base time in every logger file.  This 
provides an absolute reference that the Veriteq vLog software uses to display the logger information using 
the computer’s local time zone.  Sample files for multiple time zones have been included on the Veriteq vLog 
Qualification Protocol CD in the \samples\<timezone>\ directory. When implementing this protocol, use the 
sample files located in the directory corresponding to the time zone of the computer being used. 

The appendices contain printouts of both sample graph files and tabular data listings. For your reference, 
Appendix A lists the passwords for all Veriteq vLog sample files that are supplied on the Veriteq vLog 
Qualification Protocol CD. 

2 Responsibilities 

2.1 Vendor Responsibilities 

Veriteq Instruments, Inc. is responsible for the following: 

• IQ/OQ Protocol Template Creation 

• Initial Logger Calibration  

• Protocol Preparation 

2.2 User Responsibilities 

__________________________ is responsible for the following: 

• Equipment Maintenance 

• Ensuring Calibrated Status of Unit(s) 

• Protocol Pre-Approval 

• Protocol Implementation and Reporting of Results 

• Protocol Execution Deviations, Assessment and Corrective Measures 

• Protocol and Report Review 

• Protocol and Report Approval 

3 System Description 

The Veriteq vLog Validatable Data Logging System is a battery-operated, microprocessor-based data 
collection and PC reporting system for monitoring and recording temperature and relative humidity in FDA-
regulated environments. 

The system consists of one or more VL-1000, VL-1016, VL-1000LT, VL-1000VLT, (hereafter referred to 
collectively as VL-1000); V-1400, VL-1416 (hereafter referred to collectively as VL-1400), VL-1700 
(thermocouples), VL-4000 and/or VL-2000 data loggers; and the Veriteq vLog Windows-based software.  
The data loggers are connected to the vLog System using Veriteq serial cables, Veriteq USB cables, Veriteq 
vNet devices, and/or approved models of Digi PortServer Ethernet devices, and a PC with print capability.  
Each VL-1000 data logger, except the VLT, can optionally include one or more external temperature probes.   
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The VL data loggers are self-contained electronic recording instruments that include on-board sensors, non-
volatile EEPROM memory, a 10-year lithium battery, and a clock. The system is driven by an on-board 
microprocessor operating under Veriteq firmware, an unalterable factory-supplied program. 

The temperature sensor used in the VL loggers and in the external temperature probes is a NTC thermistor 
that varies its resistance in relation to temperature. The relative humidity sensor used in the VL-2000 is a 
capacitive sensor. It works by varying its capacitance in relation to changes in RH. Each VL data logger is 
factory-calibrated against NIST traceable standards and all calibration information is encrypted and stored 
digitally in the logger’s memory. The onboard sensors are located just inside the lower left corner of the 
plastic enclosure and are exposed to the ambient environment through ventilation openings in the enclosure. 

The external temperature probe for the VL-1000  and VL-1400 data loggers consists of a short length of two-
conductor, shielded twisted pair cable, with a plug-in connector at one end, and a thermistor, epoxy-
encapsulated in a stainless steep tip or waterproof Teflon tip, at the other end.  The probe can be used to 
provide an additional measurement channel and to allow monitoring in areas not suitable for data loggers. 

The VL-1700 series of data loggers, allows thermocouples to be used, particularly in extreme temperature 
ranges.  Completing the series, the VL-4000 series allows external devices, using Voltage or Current analog 
outputs, to be read and stored. 

The VL data loggers work by sampling and storing sensor readings at regular user-programmed sample 
intervals.  In the VL-2000, both temperature and relative humidity readings are taken simultaneously and 
stored as a set because the response of the RH sensor is temperature-dependent. When the logger data is 
downloaded to a PC, the Veriteq vLog software package automatically process the raw data and creates an 
encrypted file for display, analysis, and reporting. 

The Veriteq vLog software package is a commercial off-the-shelf program compatible with Veriteq VL and 
SP data loggers, offering data logger setup, graphing, and reporting functions.  The Veriteq vLog software 
also includes unique file identifiers and password protection for data integrity. 

4 Objective 

The objective of this protocol is to qualify the installation and operation of the Veriteq vLog software at 
__________________________. 

This protocol will verify the installation, correct functionality and operation of the Veriteq vLog software 
according to manufacturer’s specifications and the requirements of __________________________. 

 

5 Documentation Procedures 

5.1 Data generated during the execution of this protocol will be collected and recorded on the data sheets 

provided.  All supplemental information documents will be attached in the “Attached Exhibits” section of this 

protocol. 

5.2 During the execution, the executor’s initials and date will be provided at the time of completion for each 

activity. 

5.3 Handwritten data is to be neatly printed using a black or blue ball point pen.  Corrections are to be crossed 

out with a single line, initialed, and dated, with an explanation for the correction. 

5.4 Charts, printout, notes etc. generated during the execution will be dated, signed, and attached to the 

completed protocol document. 

5.5 All pages will be reviewed and signed by appropriate ______________ personnel to verify document 

completeness. 

5.6 Unless specifically required, tests and operational steps may be performed in sequences other than 

indicated. 
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5.7 Throughout this document, the use of N/A and U/A shall be interpreted as “not applicable” and 

“unavailable”, respectively.  A written explanation must be provided whenever U/A is used. 

5.8 Pages may be photocopied as needed in order to complete additional testing or perform testing required to 

resolve deviations/discrepancies.  Additional pages must be numbered appropriately to identify them as 

extra pages and to identify the order in which they appear.  Identification shall be applied using alphabetical 

characters next to the page number and a numeric group annotation to the right of the page number as it 

appears in the header.  For example, if three (3) additional copies of page seven (7) of a forty-one (41) 

page document are required, the page numbering shall be annotated to read as follows: “Page 7A of 41, 

Additional page 1 of 3”. 

5.9 Protocol Deviations 

A deviation is defined as: 

• A variance between observed conditions and acceptance criteria as stated within an approved 
protocol.  

• A variance between the approved protocol procedure and the procedure followed in the testing. 

Deviations and exceptions to approved protocols may occur. It is the responsibility of the qualification group 
to document each deviation and to provide an explanation of the circumstances that led to said deviation. 
Deviations should be documented in the space provided in each test section. 

Deviations and exceptions must be approved by the Quality Assurance group according to current standard 
operating procedures, prior to any further execution of the protocol. 
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6 INSTALLATION QUALIFICATION 

6.1 Test Plan 

Testing will be performed to verify installation of the Veriteq vLog System in conformance with 
manufacturer’s specifications and customer requirements.  The test plan consists of five sections.  These 
are: 

6.1.1 Documentation 

This section will verify the presence of all documentation necessary to qualify, maintain, and operate the 
system properly. 

6.1.2 Logger Information 

This section will verify that all Data Loggers are properly cataloged and that all configuration information 
for each logger is recorded. 

6.1.3 Computer Hardware Requirements and Configuration 

This section will verify that all required equipment is present and properly documented, and that it meets 
the hardware requirements of the Veriteq vLog system. 

6.1.4 Software Installation Verification 

This section will verify that the correct version of the Veriteq vLog software is present and properly 
installed on the PC. 

6.1.5 Logger Configuration 

This section will verify that the data logger’s system configuration has been upgraded to enable the 

Stop Time feature. 
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6.2 Documentation 

Record the following information for the system.  Fill in all applicable information. 

Document Criteria Storage Location 
(attach copies as necessary) 

Meets Criteria 
Pass/Fail 

Initials/date 

Purchase Order / Packing 

Lists 

PO matches items 

received?  Yes / No 
  

vLog installable disks 

Back up disks 

available?  Yes / No 

Location__________   

  

Calibration Program 

Calibration Program 

has been 

documented. 

  

Drawings 
Showing installation 

locations. 
  

Manuals Document # /  
Description 

Storage Location 
(attach copies as necessary) 

 

Veriteq vLog Software Quick-

Start Guide 
880-0003-01 

 
 

Veriteq vLog 

User’s Guide 

880-0206-00 

 

 

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Sufficient documentation is in place to allow the user to properly install, operate, and 
maintain the system.  All documentation is correct, current, and has been filed. 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.3 Logger Information 

Record the following information related to the logger(s).  Fill in all information that is applicable.   

This form may be duplicated as needed to complete this section. 

Model # / 
Location 

Serial # Calibration 
Certificate # 

Calibration Date Calibration Due 
Date 

Meets Criteria 
Pass/Fail 

Initials/date 

 
     

      

 
     

      

      

      

      

      

      

      

      

      

      

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Each logger has a uniquely numbered Calibration Certificate stating the model 
number, serial number, calibration date, and calibration due date for that 
particular logger. 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.4 Computer Hardware Requirements and Configuration 

Record the following information for each computer to be used in the Veriteq vLog System.  Fill in all 
information that is applicable.   

This form may be duplicated as needed to complete this section. 

PC ID / Location PC Model # Operating System Meets Hardware 
Requirements 

Meets 
Criteria 

Pass/Fail 
Initials/date 

     

     

     

     

     

     

     

     

 

       
Comments/Deviations:   

  

  

  

 

Acceptance Criteria: Is the Veriteq Interface Cable/Device present?  Yes: _____ / No: ______ 

Acceptance Criteria: Each computer must be able to connect to a Veriteq data logger using a Veriteq-
approved interface cable or device.  Approved interface cables and devices include the Veriteq Serial Cable, 
the Veriteq USB cable (with drivers installed), the Veriteq vNet device, and a selection of Ethernet to Serial 
devices manufactured by Digi International (with drivers installed).  Each computer must be running one of 
the following approved operating systems: Microsoft Windows 2000, Microsoft Windows XP, Microsoft 
Windows Server 2003, Windows Vista, Windows Server 2008, or Windows 7.  

 

 

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.5 Software Installation Verification  

Follow the steps below to confirm installation of the Veriteq vLog 4.4 software. 

Note: The software must only be installed on a PC that has passed the Hardware Requirements and 
Configuration qualification (Section 6.4 of the vLog IQ/OQ Protocol). 

Step Procedure Acceptance Criteria Meets 
Criteria 

Pass/Fail 
Initials/date 

6.5.1
Enter the PC ID for the computer used: 

________________________________ 

The PC ID is recorded.  

6.5.2
Insert the Veriteq vLog 4.4 software CD into 

the computer’s CD-ROM drive. 

If this is a new installation, the InstallShield 

Wizard starts and the Welcome dialog box 

appears.
1   

Skip to Step 6.5.6. 

If you are upgrading from a previous version of 

vLog, you will be asked if you wish to uninstall 

the previous version.  Proceed to step 6.5.3.
  
 

 

6.5.3
Click Yes to uninstall the previous version of 

vLog. 

The InstallShield Wizard asks if you wish to 

completely remove the application and its 

features. 

 

6.5.4
Click Yes. The InstallShield Wizard confirms that the 

Uninstall is complete. 

 

6.5.5
Click Finish. The InstallShield Wizard for vLog starts and 

the Welcome dialog box is shown. 

 

6.5.6
Click Next. The License Agreement is shown.  

6.5.7
Select “I accept the terms of the license 

agreement”, and click Next. 

The Choose Destination Location dialog box 

appears. 

 

6.5.8
Click Next to accept the default installation 

location. 

The Select Program Folder dialog box 

appears. 

 

6.5.9
Click Next to accept the default Program 

Folder. 

The files are copied and the InstallShield 

Wizard Complete dialog box appears 

confirming that “Setup has finished installing 

vLog on your computer”. 

 

6.5.10
Click Finish. Installation is complete and the Wizard closes.  

6.5.11
From the Start menu, select Programs > 

Veriteq Instruments > vLog 4.4 > vLog to 

start the Veriteq vLog program. 

For a new installation, a dialog box appears 

stating that Veriteq vLog is “unable to find the 

vLog security file”, and prompts the user to 

create a new one.   
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Step Procedure Acceptance Criteria Meets 
Criteria 

Pass/Fail 
Initials/date 

 
 If you are upgrading, the message states that 

the security file was created by a previous 

version of vLog.  You have the option of 

updating the file or deleting and creating a new 

one.   

 

6.5.12
Click Yes. The vLog Security Wizard prompts the user to 

retrieve the software security key, and the user 

name and password of an existing Windows 

Account. 

Note: This user will be granted vLog 

ADMINISTRATOR status.   

 

6.5.13
Click Next. The vLog Security Wizard page is shown, 

prompting the user to enter the CD security 

key. 

 

6.5.14
Enter the CD security key, and click Next. Upon successful security key entry, the vLog 

Security Wizard administrator account setup 

page is shown. 

 

6.5.15
Enter the Administrator’s Windows 

Authentication User name and Password, 

and the Full name by which the user is 

identified.  Click Next. 

Upon successful entry of administrator’s 

details, the wizard prompts the user to specify 

the audit trail folder location.  

 

6.5.16
Click Next to accept the default file location. The vLog Security Wizard Security Level page 

is shown. 

 

6.5.17
Select High Security and click Finish. The vLog program now starts.  

6.5.18
Click Help > About Veriteq vLog from the 

menu bar. 

The Veriteq vLog box appears, displaying the 

software version in bold letters. 

 

6.5.19
Click the Veriteq vLog box. The Veriteq vLog box disappears.  

6.5.20
Click File > Exit. vLog closes.  

1
If the CD Autorun feature is disabled on your system, the installation must be manually started by double-
clicking on the file D:\SETUP.EXE, where D: is the letter of your CD-ROM drive. 

 

Comments/Deviations:   
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Acceptance Criteria:  All Acceptance Criteria have been met and the Veriteq vLog Version 4.4 software is 
installed successfully.  

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.6 Test User Security Level Information 

Using the Administrator account set up in Step 6.5.15, create the local vLog accounts as listed below.  If the 
vLog Administrator account created during software installation is not the “administrator” account you wish to 
use during the protocol execution, create a second “Admin” account.  These accounts will be used during 
the Operation Qualification testing.   All accounts use Windows authentication.  The User and Guest 
accounts must be either 2 existing Domain accounts, or new Local accounts created in advance by the 
Local Administrator. 

Procedure: 

1. Login to vLog using the Administrator’s Domain user name and password. 

2. Go to Tools > Administrator Options. 

3. Select the Security tab and click Add.  Enter the information as listed in the table below. 

4. Click OK. 

5. Click Test and enter the user’s password.  Click OK.  If the setup has been successful, the 
message “The specified user credentials were successfully authenticated in Windows” appears. 

6. Repeat the process for each user listed. 

7. When finished, click OK. 

8. Click File > Exit. 

Name Password User Role 

 

Use Windows 
Authentication 

Local/Domain 

 

Meets Criteria 
Pass/Fail 

Initials/Date 

<Admin> 
(If applicable) 

********** Administrator <Domain> 
 

User1 User1 User <Local> 
 

Guest1 Guest1 Guest <Local>  

 

 

Comments/Deviations:   

  

  

  

 

Acceptance Criteria:  All test users have been configured to have correct access level to the Veriteq vLog 
software via the vLog user logon.   

Acceptance Criteria Met?  Pass/Fail: _____________                  Initials/Date: _______/  

Reviewed by:    ____________________________________     Date:   
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6.7 IQ Final Approval 

The procedures in this section have been implemented, reviewed, and approved by the individuals listed 
below.  All results have been documented and all deviations have been identified, documented, reviewed, 
and approved.   

Note:  The Final “Approvers” should be the same as the original protocol approvers when available. 

Upon final approval OQ testing may commence. 

 

Implemented by: _____________________________ Initials: ______ Date: ______ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Reviewed by:  _______________________________ Initials: ______ Date: ______ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by:  _______________________________ Initials: ______ Date: ______ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

QA Approved by:  _______________________________ Initials: ______ Date: ______ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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7 Operational Qualification Methodology 

7.1 Test Plan 

Testing will be performed to verify that the operation of the Veriteq vLog System is in conformance with 
manufacturer’s specifications and customer requirements.  The Acceptance Criteria for all sections are 
derived from Veriteq Instruments’ recommendations.  The test plan will consist of four main sections, as 
defined below.   

7.1.1 Functional Testing 

Functional testing will verify the following capabilities of the Veriteq vLog software: 

- Veriteq vLog Software Setup 

- Logger Communication 

- Batch Transfers 

- Graph Files 

- Graph Titles 

- Time Axis Settings 

- Scrolling and Zooming 

- Logger Files and the Cursor 

- Multiple Logger Files 

- Axis Units and Range 

- Printing of Secure and Non-Secure Logger Files 

- Data Integrity and Security 

7.1.2 Statistical Testing 

Statistical testing will ensure that the data within the files is correctly displayed, and calculated to 
provide validated results. 

- Instantaneous Value Reports 

- Channel Minimum, Maximum and Average Reports 

- Channel Statistical Deviation Reports 

- Group Minimum, Maximum and Average Reports 

- Group Statistical Reports 

- Channel and Group Mean Kinetic Temperatures 

- Lethality 

 

7.1.3 Audit Testing 

Uneventful testing will test the Auditing of Veriteq vLog System interaction as a whole, and will consist 
of the following parts: 

- Linking Loggers to an Audit Trail 

- Single Logger Processing 

- Batch Logger Processing 



   
Page 18 of 22 

 

© Copyright 2010 Veriteq Instruments, Inc.   Initials: ________  Date:___________ 

 

- User Account Privileges 

- Account Security 

- Data Accuracy 

- Audit File Integrity 

- Security File Integrity 

- Batch File Integrity 

, 

7.1.4 Eventful Testing 

Eventful testing is concerned with testing unexpected events.  The tests will verify that the Veriteq vLog 
System can handle these unexpected events with no loss or corruption of data.  These events are: 

- Logger Disconnection During Transfer 

- System Power Loss During Transfer 
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7.6 OQ FINAL APPROVAL 

The procedures in this section have been implemented, reviewed and approved by the individuals listed 
below.  All results have been documented, all generated reports have been attached to this document and 
all deviations have been identified, documented, reviewed and approved. 

 

Implemented by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Reviewed by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

QA Approved by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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8 Signature Identification Form 

All personnel assigned to execute or review this executed protocol, attached deviations, modifications and/or 
supporting documentation must sign and initial in the space provided below.  Signature also indicates the 
individual has read and understands the protocol prior to task execution.  In the affiliation and title 
column fill in company name and designated title. 

 

Printed Name Signature Title/Affiliation Initials/ date 

    

    

    

    

    

    

    

    

    

    

 

Comments/Deviations:   

  

  

  

 
 

Implemented by:   _______________________________________ Date: _____________ 

Reviewed by:      _______________________________________ Date: _____________ 
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9 IQ/OQ DOCUMENT FINAL APPROVAL 

 

The Veriteq vLog System has passed all tests, and as such, is qualified to be used in the 
_________________________environment: 

      

 

Reviewed by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 

 

Approved by:  _______________________________ Initials: ______ Date: __________ 

  Name (Print):  __________________________ 

  Title:  __________________________ 

  Company: __________________________ 
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10 DOCUMENT HISTORY 

Note:  This section is for internal tracking purposes and may be omitted depending on your procedure for 
validation document revisions, SOP #______ . 

 

Document # Description of changes Date By 

    

    

    

 

 

 

 
 

 


